RPM Implementation Review – Draft 11/12/13

Introduction

A crisp statement of the background for this review is provided in the statement of work of the contract between the Council and the author:

The Council develops 20-year Power Plans to ensure the Pacific Northwest region will have adequate and reliable power at the lowest economic and environmental cost. RPM was designed, developed and used by Council staff for the Fifth and Sixth Northwest Power Plans, issued in 2005 and 2010 respectively. RPM uses a methodology that differs from commercially-available electric utility resource planning models.

The RPM methodology recognizes that at certain points in the Council’s 20-year planning horizon, the region will need new resources, and that new and better information will be available at the times when major commitments must be made to meet those resource needs. Thus, the focus of the RPM methodology is not to identify a static, 20-year schedule of planned resource additions that depends on inherently uncertain forecasts. Instead, RPM focuses on a) identifying resource strategies that can be adapted as new information becomes available during the planning period, b) reducing exposure to high cost under unexpected circumstances – such as extreme fuel costs or environmental mitigation legislation, and c) minimizing exposure to large negative consequences of major under- or over-commitments to new resources. Significantly, costs and risks are those for regional ratepayers. This last factor is especially significant to new resources. A schedule of new resources is a key product of the resource planning process. The method that expands resource capacity must recognize the costs and risks for regional ratepayers and not some larger system.

The Council has recognized a need to redevelop RPM using updated software tools1. The redevelopment effort is intended to maintain the most salient aspects of the RPM methodology while improving the software to make it more robust, fully documented, and usable by more resource planning staff. To facilitate the RPM redevelopment process, it is important to document the current status of the existing software and its usability.

The present report is the result of a review of the current status and usability, with some guidance for a prospective redevelopment effort.

The Existing Implementation of RPM

The Regional Portfolio Model (RPM) develops a set of candidate plans and evaluates these plans over a broad set of possible futures over a 20-year horizon. It presents various measures regarding the performance of the plans, two of which are an expected cost and a risk metric. These two measures aid the Council in understanding the economics of the various plans, the impact of various uncertainties,
and the trade-off between expected cost and risk. Cost includes both controllable costs, which result directly and immediately from implementation of a plan, and uncontrollable costs, which are driven by uncertain external causes.

RPM is a system consisting of many interconnected components. One of the key components is a complex Excel spreadsheet model called RPM, that performs the physical and economic calculations for a given plan and future. RPM is driven by an Excel add-in called Crystal Ball, which creates multiple futures and triggers Excel to recalculate the spreadsheet for a given plan and each of these futures. Crystal Ball is driven, in turn, by OptQuest, a related add-in, that creates a large number of plans to be evaluated by Crystal Ball and the spreadsheet, for each future. A typical simulation with RPM/Crystal Ball/OptQuest entails 5000 plans and 750 futures.

The components of RPM are shown in Figure 1. These components are divided into three categories – Prepare Input Data, Run RPM, and Analyze Results. Flow generally proceeds from left to right.

The components are listed in Table 1. They are divided into the same three categories and are arranged in order of the primary steps associated with them in ref. [1], which is attached as an appendix for the convenience of the reader. This document is included as an attachment for reference. The primary steps are distinguished by bold font. Components not explicitly mentioned in steps are listed immediately after components with which they are most closely associated. Components not mentioned or implied in ref. [1] are listed in a logical order relative to the other components. At the bottom of the table are listed “Other Components” and “Obsolete Components.” Components are placed in one of these two sections if they are mentioned in a document listed under “References,” but are no longer currently used.

The table provides a brief description of the component, primary inputs used and primary outputs produced by the component, the platform on which it is based, additional comments, and the location(s) of documentation. Also provided is a priority number, indicating a recommendation on how to address each component in a redevelopment process. Notes on interpreting these numbers appear at the bottom of the table, and priority is discussed more extensively below, in the section RPM Reimplementation.

AllSector Supply.xls → (Further Processing) → Conservation Supply Curves 

HYDSIM Algorithm in GENESYS → Trapezoidal Model 

Depand Response Data → RPS Estimates < penetration >% → RPS Assumptions 

Hydro Data → Inserting and Removing Plants 

Contracts Data → Paste into RPM 

Fuel Price Data → RPM Workbook 

Load Forecast Data → Crystal Ball / OptQuest 

Other Inputs → Manual Input 

“RPM” → Initialization 

Standalone Export to Access → (Access Database) → Import to Excel 

Log File → Analysis of Optimization Run 

Snapshot Utility → Feasibility Space / Efficient Frontier 

Spinne Graph → Diagnostics and Special Inquiries 

RPM Reader 

Figure 1. RPM Process Flow Diagram.
Table 1. Components of RPM.

<table>
<thead>
<tr>
<th>Step *</th>
<th>Component</th>
<th>Description</th>
<th>Input</th>
<th>Output</th>
<th>Platform</th>
<th>Comments</th>
<th>Documentation</th>
<th>Priority †</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Prepare Input Data</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Projects Master Workbook</td>
<td>This workbook contains the data for all existing and planned PNW generating resources, except hydro other than independent hydro.</td>
<td></td>
<td>MS Excel</td>
<td></td>
<td>This workbook exists independently of RPM and provides data to other models in addition to RPM, including Aurora and GENESYS.</td>
<td>[2], L-92.</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>[2], L-97.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resource DB</td>
<td>This database holds data from the Projects Master Workbook and prepares it for transfer to RPM. It includes an Access form (the Wizard) that provides an interface to macros for performing the tasks at the right.</td>
<td>Resource Projects Workbook</td>
<td>Data rows to paste into RPM</td>
<td>MS Access</td>
<td>The Wizard masks the 44 queries in the database, only three of which are left visible to the user. All but one of the 19 tables are visible, but the user interacts with only a half dozen of these. The macros included the following tools: Unit Comparison (against previous data) Create workbook with records to past in RPM Assists the user with an R method for cluster analysis on resource operating features Create Workbook Bubble Chart of Clusters, to illustrate aggregates of resources</td>
<td>[3] [4]</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PRM New Resource Assumptions</td>
<td>This workbook contains parameters for new generic resources</td>
<td></td>
<td></td>
<td>MS Excel</td>
<td></td>
<td></td>
<td>3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Converting Overnight to Period Costs v08.xls</td>
<td>Worksheet to convert costs for use with RPM’s standard periods.</td>
<td></td>
<td>MS Excel</td>
<td></td>
<td>Used in developing new resource assumptions.</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>New resource</td>
<td>Processed new resource data</td>
<td></td>
<td>MS Excel</td>
<td></td>
<td>Provided in ad hoc files and manually</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>Step *</td>
<td>Component</td>
<td>Description</td>
<td>Input</td>
<td>Output</td>
<td>Platform</td>
<td>Comments</td>
<td>Documentation</td>
<td>Priority</td>
</tr>
<tr>
<td>--------</td>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>--------</td>
<td>----------</td>
<td>----------</td>
<td>---------------</td>
<td>----------</td>
</tr>
<tr>
<td></td>
<td>assumptions</td>
<td>for RPM</td>
<td></td>
<td></td>
<td></td>
<td>pasted into RPM</td>
<td></td>
<td></td>
</tr>
<tr>
<td>All Sector Supply mmddyy.xls</td>
<td>This workbook contains projections for conservation</td>
<td></td>
<td></td>
<td>MS Excel</td>
<td></td>
<td>[2], L-102.</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>On- and Off-Peak Conservation yymmd.xls</td>
<td>Intermediate step in processing conservation projections</td>
<td></td>
<td></td>
<td>MS Excel</td>
<td></td>
<td>[2], L-96.</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>Olivia Conservation yymmd.xls</td>
<td>Intermediate step in processing conservation projections</td>
<td></td>
<td></td>
<td>MS Excel</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conservation supply curves</td>
<td>Processed conservation data for RPM</td>
<td></td>
<td></td>
<td>MS Excel</td>
<td>manually pasted into RPM</td>
<td>[2], L-102.</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>RPS Estimates 6P 95% 090911_MUS.xls</td>
<td>This workbook contains projections for RPS resources</td>
<td></td>
<td></td>
<td>MS Excel</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RPS assumptions</td>
<td>Processed RPS data for RPM</td>
<td></td>
<td></td>
<td>Various</td>
<td>manually pasted into RPM</td>
<td>[2], L-96.</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>HYDSIM algorithm within GENESYS</td>
<td>Produces hydro energy projections</td>
<td>Historical river flow data, plant capacity, policy parameters</td>
<td>Energy production, conditioned on hydro year and location</td>
<td>Includes independent hydro units, which in principle are not included in the Projects Master Workbook, nor price responsive hydro, which is modeled directly in RPM.</td>
<td>[5], [2]</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trapezoidal Model</td>
<td>Calculates sustained peaking capability from energy</td>
<td>Energy projections</td>
<td>Sustained peaking capability</td>
<td>Output used by the RPM is in Excel</td>
<td>This may not be required in future, as Genesys may be modified to provide 16-hr peaking values. Priority = 4, assuming Genesys is so modified.</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Demand Response data</td>
<td>Capacity, maximum number of hours available by season, variable costs, fixed costs</td>
<td></td>
<td></td>
<td></td>
<td>DR can be represented in the same detail as any supply-side resource</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contracts data</td>
<td>On- and off-peak firm contracts for imports to and exports from the region.</td>
<td>Contracts data from BPA</td>
<td></td>
<td></td>
<td>[2], L-107.</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Step*</td>
<td>Component</td>
<td>Description</td>
<td>Input</td>
<td>Output</td>
<td>Platform</td>
<td>Comments</td>
<td>Documentation</td>
<td>Priority</td>
</tr>
<tr>
<td>-------</td>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------</td>
<td>--------</td>
<td>----------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>----------</td>
</tr>
<tr>
<td></td>
<td>Fuel price data</td>
<td>Average price on- and off-peak, if appropriate and hourly correlations in each of those subperiods with hydrogenation, loads, and electricity prices.</td>
<td></td>
<td></td>
<td>MS Excel</td>
<td>Pasted into RPM</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Load forecast data</td>
<td>Average loads on- and off-peak, and hourly correlations in each of those subperiods with hydrogenation, fuel prices, and electricity prices.</td>
<td></td>
<td></td>
<td>MS Excel</td>
<td>Pasted into RPM</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Other inputs</td>
<td>Manual inputs</td>
<td></td>
<td></td>
<td></td>
<td>These include “other regulatory uncertainties “ and other parameters:</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Production tax credits</td>
<td></td>
<td></td>
<td></td>
<td>• Renewable energy credit</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• CO₂ penalty</td>
<td></td>
<td></td>
<td></td>
<td>• Aluminum smelters</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Server farms</td>
<td></td>
<td></td>
<td></td>
<td>• East-West price differential</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Decision criterion (an energy adequacy target derived from 1-in-5 LOLE)</td>
<td></td>
<td></td>
<td></td>
<td>• Discount rate</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Other environmental costs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inserting and Removing</td>
<td>Excel add-in that adds or deletes rows for plant data, and modifies formulas using plant data accordingly</td>
<td></td>
<td></td>
<td>MS Excel</td>
<td>Uses the following Excel tools as diagnostics:</td>
<td>[4], 7.</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Plants</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Inventory Precedents</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Inventory Dependents</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Includes the following tools:</td>
<td></td>
<td></td>
<td></td>
<td>• Insert Rows</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Install Template (for an additional power plant)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Step</td>
<td>Component</td>
<td>Description</td>
<td>Input</td>
<td>Output</td>
<td>Platform</td>
<td>Comments</td>
<td>Documentation</td>
<td>Priority</td>
</tr>
<tr>
<td>------</td>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
<td>---------</td>
<td>-----------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>----------</td>
</tr>
</tbody>
</table>
|      |                  |                                                                             |         |         |           | + Identify New Range Names  
|      |                  |                                                                             |         |         |           | • Verify the referencing in new formulas for the safe copying across columns and rows.  
|      |                  |                                                                             |         |         |           | • Reprogram Dependent Cells  
<p>|      |                  |                                                                             |         |         |           | • Edit Dependents (not implemented)                                                                                                             |               |          |
|      |                  |                                                                             |         |         |           |                                                                                                                                             |               |          |
| Run RPM |                  |                                                                             |         |         |           |                                                                                                                                             |               |          |
| 1-5  | Clean and Restart| This script cleans up the virtual machines to be used in running RPM.       | None    | None    | PowerShell| Included in Initialization. Need to access to vModel2 through VNC.                                                                               | [1], 2.        | 4        |
| 11   | Documentation file| This is a permanent journal in which the user enters a record of actions and results in a sequence of RPM studies. | Manual input | None    | Word document | The user may monitor this file to observe the progress of a study. It needs to be backed-up manually to avoid overwriting results in a subsequent run. | [1], 2.        | 3        |
| 15-16| OptQuest log file | This is created as OptQuest runs. It contains the statistical results for each resource strategy simulated. | None    | Key OptQuest results | Text file |                                                                                                                                             | [1], 3.        | 1        |
| 18   | Text log file    | This is a temporary log in which the user enters notes of actions and progress running a particular study. | Manual input | None    | Text file | The user may monitor this file to observe the progress of a study. It needs to be backed-up manually to avoid overwriting results in a subsequent run. | [1], 3.        | 3        |
| 6-9, 13-14, 17, 19-21 | RPM Workbook | The physical and economic relationships and data are embodied in a single worksheet. | Input data are copied from other sources and pasted into the worksheet. | NPV constant dollars for a resource strategy under a single future. | MS Excel | A new model is typically created by copying a previous model. A new model can be created from scratch by running Olivia. Need to access to vMaster through VNC. | [1], 2.        | 1        |</p>
<table>
<thead>
<tr>
<th>Step</th>
<th>Component</th>
<th>Description</th>
<th>Input</th>
<th>Output</th>
<th>Platform</th>
<th>Comments</th>
<th>Documentation</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>NWPCCRisk07</td>
<td>An add-in for hourly dispatch</td>
<td></td>
<td>MS Excel XLL add-in</td>
<td>Invoked by user to initialize workbook.</td>
<td>[2], L-111; [1], 3.</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>22-23</td>
<td>&lt;Ctrl&gt;-M</td>
<td>Invokes the RPM macro that checks for other open workbooks and loads the names of macros used by Crystal Ball.</td>
<td>None</td>
<td>None</td>
<td>Invoked by user to initialize workbook.</td>
<td>[2], L-109; [1], 3.</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>24-25</td>
<td>&lt;Ctrl&gt;-I</td>
<td>Invokes the AutoOpen macro: An RPM initialization macro that performs recalculation.</td>
<td>None</td>
<td>None</td>
<td>Invoked by user to initialize workbook.</td>
<td>[2], L-109.</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>Crystal Ball</td>
<td>An Excel add-in that performs stochastic simulations with RPM.</td>
<td>Data in RPM workbook; Control parameters</td>
<td>Some results reported in Excel ranges. Most results stored in volatile memory.</td>
<td>MS Excel add-in</td>
<td>This add-in opens when the RPM workbook is opened in Excel.</td>
<td>[2], L-109.</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Crystal Ball</td>
<td></td>
<td></td>
<td>Manual input to crystal ball</td>
<td></td>
<td></td>
<td>[5]</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>Crystal Ball</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>[2], L-110; [1], 3.</td>
<td>4</td>
</tr>
<tr>
<td>-</td>
<td>subAfterGame</td>
<td>Macros triggered by Crystal Ball</td>
<td>None</td>
<td>The macro subAfterGame fires worksheet calculations in period order</td>
<td>MS Excel add-in</td>
<td>Names are loaded into Crystal Ball by &lt;Ctrl&gt;-M.</td>
<td>[2], L-110; [1], 3.</td>
<td>4</td>
</tr>
</tbody>
</table>

Note: The OptQuest results are saved in the OptQuest log file. Respond “no” to the inquiry “Do you want to save results to Excel?” prompt at the end of an RPM/CB/OptQuest run. The plan stored in the RPM workbook will depend on the intentions of the user.
<table>
<thead>
<tr>
<th>Step</th>
<th>Component</th>
<th>Description</th>
<th>Input</th>
<th>Output</th>
<th>Platform</th>
<th>Comments</th>
<th>Documentation</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>(by column)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>and modifies</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>cells values</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>for electricity</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>price adjustment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>to achieve energy</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>balance in each</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>subperiod</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10, 27- 28a</td>
<td>OptQuest Control file (*.opt)</td>
<td>This small text file contains parameters for an OptQuest run.</td>
<td>Previous version</td>
<td>None</td>
<td>Text file</td>
<td>This file is updated using both a text editor and dialogs in OptQuest</td>
<td>[1], 3.</td>
<td>1</td>
</tr>
<tr>
<td>26, 28b- 28e</td>
<td>OptQuest</td>
<td>An optimization engine embedded within Crystal Ball</td>
<td>Control file</td>
<td>Log file</td>
<td>MS Excel add-in</td>
<td>The RPM/CB/OptQuest system is invoked in OptQuest.</td>
<td>[2], L-112; [1], 3.</td>
<td>1</td>
</tr>
</tbody>
</table>

**Analyze Results**

| 12, A | Analysis of Optimization Run (subProcess) | Creates display of plans in the feasibility space and a comparison of feasibility spaces. | OptQuest.Log file | Feasibility spaces, efficient frontiers, near-efficient plans | MS Excel workbook and macro | Typically requires a separate RPM/CB run, in Normal mode. Includes diagnostics for non-conforming range names. User can select a “configuration” to load, e.g., Spinner Graph. | [2], L-116; [1], 4. | 2 |

**B**

| Standalone Export to Access.xls | Creates an Access database of results for all trials of a specified plan. | RPM cell values and arrays (volatile memory) | Populates tables of data with results for all trials and a specified plan. | MS Excel macro and form | | [1], 4; [4], 8. | 1 |

- Access DB of results, Auditor PPPP YYMMDD HH MM.mdb, where PPPP refers to a particular model base case and resource plan | Selected variable results for all trials and a specified plan. | RPM model configured with a specific resource strategy and a current “Auditor template.mdb” | Various standard reports and principal data source for diagnostics and special studies | MS Access | Created by Standalone Export to Access.xls. Includes: • Form frm_SpinnerPrompt to create a Spinner Graph workbook. • Macro subCreateDeciles to prepare frequency decile graphs for selected variables, such as new | [1], 4. | 1 |
<table>
<thead>
<tr>
<th>Step</th>
<th>Component</th>
<th>Description</th>
<th>Input</th>
<th>Output</th>
<th>Platform</th>
<th>Comments</th>
<th>Documentation</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>C</td>
<td>Spinner Graph</td>
<td>A workbook presenting graphs showing the results for all trials and a specified plan.</td>
<td>Resource database (see above) and thus ultimately an OptQuest log file</td>
<td>New workbook template</td>
<td>Created by frm_SpinnerPrompt, with specified spinner workbook template.</td>
<td>[1], [5]; [4], 8..</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>D</td>
<td>RPM launch sequence for single-plan, 750 futures</td>
<td>Alternative approach for extracting data from Crystal Ball.</td>
<td>Forecasts generated in Crystal Ball</td>
<td>Worksheet containing Crystal Ball results</td>
<td>Data available for only a small number of variables in Crystal Ball, as identified in the OptQuest control file.</td>
<td>[1], 6. (called “Olivia launch sequence in this reference)</td>
<td>?</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td>SnapShot Utility</td>
<td>Creates a workbook with “hot models” of a plan under a specified set of futures.</td>
<td></td>
<td>SnapShot models</td>
<td>Embedded in Snapshot120628 1730.xls workbook. Must copy SnapShot tab to RPM workbook. Must add call to wkshtSnapShot in the macro that CB runs after each game. Requires run of Crystal Ball with RPM. This took is needed because Crystal Ball cannot single-step through trials.</td>
<td>[6]; [4], 9.</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td>Import to Excel</td>
<td>Extracts and displays time series data from a database created by Export to Access.</td>
<td>Time series data</td>
<td>Graphs</td>
<td>Also called the “oscilloscope” tool (Note that this tool never made it past the proof-of-concept stage.)</td>
<td>[4], 8.</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td>RPM Reader</td>
<td>A workbook that reads sets of data into ranges in a target worksheet – which may be from any application – and calls the user’s macros on the worksheet populated with each set.</td>
<td>Rows of data, each of which contains values for all target cells in the target worksheet. Each row represents a separate set of data. (Input data can also be organized in columns.)</td>
<td>User-selected cell values.</td>
<td>This tool has been applied to the energy efficiency calculator in the RPM (RPM Conservation P03b.xls), preparation of input data and extraction of output data (DUG workbook calculations), and study of power plant dispatch in carbon mitigation studies. It could be populated with CB random variables to replicate all futures in the RPM.</td>
<td>XXX</td>
<td>2</td>
</tr>
<tr>
<td>Step *</td>
<td>Component</td>
<td>Description</td>
<td>Input</td>
<td>Output</td>
<td>Platform</td>
<td>Comments</td>
<td>Documentation</td>
<td>Priority</td>
</tr>
<tr>
<td>--------</td>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------</td>
<td>----------------------------------</td>
<td>----------</td>
<td>--------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
</tr>
<tr>
<td></td>
<td>sub_Compare</td>
<td>Locates and compares identical plans from two feasibility spaces, that is, their intersection.</td>
<td>Analysis of Optimization workbooks</td>
<td>VBA</td>
<td>macro sub_Compare is in module mod_ComparisonOfPlans.bas Used primarily as a diagnostic tool.</td>
<td>[2], L-120.</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>subTarget</td>
<td>Calculates stochastic adjustment to make mean or mode price match a benchmark price.</td>
<td>RPM workbook</td>
<td>Adjusted distributions</td>
<td>VBA</td>
<td>Used to scale a distribution from RPM to make the mean or mode of the resulting distribution match a point forecast. Macro in RPM</td>
<td>[2], L-121.</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Diagnostics and special studies</td>
<td>Ad hoc analyses of RPM results for diagnostic and other purposes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Obsolete Components</td>
<td></td>
<td>Olivia</td>
<td>Builds RPM models</td>
<td>RPM workbook</td>
<td>VB6.0</td>
<td>The purpose was to allow utilities to build their own models to analyze their own loads, resources, and options using the RPM logic. It was developed to facilitate use of RPM by utilities. It can also edit models. The original version of Olivia has been obsolete for many years. It has not been updated to keep up with changes in RPM. It has not been used by NWGCC in development of power plans. Rather, a new model is created by copying from a previous version and modified.</td>
<td>[2], L-136.</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IfPFCap sPFCost</td>
<td>These Excel user-defined functions (UDF) extract planning status and cost for each cohort of a new resource.</td>
<td>MS Excel UDF</td>
<td></td>
<td>No longer used. Replaced by EtA6.0 extractions.</td>
<td>[2], L-74.</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>L24DW02-f06-P.xls</td>
<td>Old demonstration version of spinner graph.</td>
<td>Spinner Graph</td>
<td></td>
<td>Runs Crystal Ball simulation for a specified plan and future. Then macro subCBAssumptionCopy can copy the assumptions for that future to another</td>
<td>[2], L-118.</td>
<td>4</td>
</tr>
<tr>
<td>Step *</td>
<td>Component</td>
<td>Description</td>
<td>Input</td>
<td>Output</td>
<td>Platform</td>
<td>Comments</td>
<td>Documentation</td>
<td>Priority †</td>
</tr>
<tr>
<td>--------</td>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>--------</td>
<td>----------</td>
<td>----------</td>
<td>---------------</td>
<td>------------</td>
</tr>
<tr>
<td></td>
<td>worksh...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Step is the step number in ref. [1]. Major sub-steps are indicated as 28a, 28b, etc.

- “A” denotes “Creating the feasibility space graph and resource plans report” in [1].
- “B” denotes “Extracting data (for spinner graphs, diagnostics, decile charts, etc.)” in [1].
- “C” denotes “Generating spinner graphs from RPM model” in [1].

† Priority indicates the recommended from this review regarding inclusion of each component in a redevelopment effort. Inclusion of a component means that its purpose be served somehow in the functionality of the new system, not necessarily that the new system replicate the current component.

- “1” denotes core functionality to be included in the base redevelopment project.
- “2” denotes other desirable functionality that is not necessarily critical to complete the seventh plan and could be selectively developed in parallel with core functionality once particular basic core design parameters are set, such as data storage architecture.
- “3” denotes functionality, such as input data preparation, that might best be left outside the new system.
- “4” denotes components that will not be needed in the new system because they would be either redundant or irrelevant.
The Usability of RPM

RPM works, and provides very valuable information and insight; but it is difficult to use. RPM is built on multiple technological platforms. Owing to this, approximately 30 manual steps are required to run RPM. (ref. [1]) It requires a highly skilled and experienced user, with detailed knowledge in the variety of platforms underlying the various components as well as in the subject matter. With all of the manual steps, there are many places where things can go wrong. An advanced level of expertise is required when things go wrong to diagnose the problem and fix it.

Since RPM is implemented in Excel and logic changes typically involve changes in Excel, the user is also a developer, not just a user. Further, the number of environments multiplies the risk of problems.

The time required for performing an RPM study and for development of RPM is documented in ref. [7].

RPM Technology

As noted above, the heart of the RPM system is a Microsoft Excel workbook, driven by the Crystal Ball and OptQuest add-ins. Three other platforms are also involved in supporting the process, Microsoft Access, Microsoft Windows, and PowerShell. These platforms are discussed in this section.

Microsoft Excel

The RPM worksheet is the core of the system. Here the input data describing the plan and the future are processed to determine energy balance and costs. It includes an economic dispatch calculation. The methodology is described in ref. [2].

The implementation uses several features to speed calculations and facilitate data communication with other components. Various utilities for preparing input data and analyzing results have also been built in Excel. The Excel features utilized include:

- Macros embedded within the RPM and utility worksheets to facilitate calculations and data transfer, and perform diagnostics.
- User-defined functions (UDFs) to perform complex calculations.
- Range names to identify the location of data to be passed between RPM and other components.
- A macro that calculates particular RPM ranges in a specified order, to speed up recalculation of the workbook, relative to Excel’s default recalculation process.

The process for manipulating and validating resource data from the projects workbook and getting it into RPM used to take four weeks. Now it takes about four hours, unless the user encounters errors that require coordination with other staff members and subject experts. This efficiency is achieved using macros that Dr. Schilmoeller has created. It has also produced a much more reliable final data set. Inconsistencies and errors in Project Workbook data are easier to identify.

13
A primary motivation for using Excel is to make RPM calculations visible to the user and the public, by allowing users and stakeholders to inspect the workbook and examine the cell formulas. However, this comes at the cost of exposing a good deal of formula references and at the increased risk that formulas will be incorrectly entered initially or modified subsequently. Yet, there are diagnostics that can be run to identify inconsistencies.

Another risk arises from the fact that the RPM workbook uses an older, unsupported version of Excel, v. 2003. (Ref. [1], 2) This is because of the version of Crystal Ball used for RPM does not recognize subsequent versions of Excel. To switch to a newer version of Excel would require coordinated switching to newer versions of Crystal Ball and OptQuest or competitor products, and finding ways to cover whatever necessary feature are missing from the newer products. This would entail significant changes to the way in which RPM communicates with these add-ins.

**Crystal Ball**

Crystal Ball enables the user to run an Excel workbook for a large number of scenarios, called “futures” in the context of RPM. These futures are constructed by sampling from probability distributions, specified by the user, expressing a state of information on key uncertainties regarding the future. The sampling approach used for RPM is called Latin hypercube sampling and Sobol sequences (for simulating forced outages), which are more efficient than generic Monte Carlo sampling in constructing a set of futures that spans the space of the uncertainties. The Monte Carlo option is also available in Crystal Ball. The approach and the distributions used in the fifth plan are documented in [8].

Key advantages of Crystal Ball are:

- It works with Excel.
- It is easy to use.
- It has convenient tools for specifying and displaying distributions.

However, a key risk is that RPM currently uses an older version of Crystal Ball, version 2000. But this version is no longer available or supported. Therefore, a change would be needed if RPM were to be made available for use by others using the same general Excel/Crystal Ball/OptQuest approach. Further, functions needed to create efficient frontiers are not supported in newer versions of Crystal Ball, and there are incompatibilities with RPM, both requiring changes to the way RPM would interact with Crystal Ball. A competing product, @Risk, poses similar problems. (Ref. [4], 3)

There are a couple of other issues relating to Crystal Ball:

- The set of futures generated by Crystal Ball in an automatic run through all the futures is inconsistent with the set generated when single-stepping through the futures. Therefore, Dr. Schilmoeller has had to create a work-around, called the SnapShot utility to obtain consistent sets.

- The user must ensure that all Monte Carlo parameters in Crystal Ball identical between runs in order to get the same set of futures.
**OptQuest**

OptQuest is an Excel add-in that is coupled with Crystal Ball to create a plan that optimizes a specified objective function given prescribed constraints and an initial plan. The set of plans that OptQuest creates in a run of RPM/Crystal Ball/OptQuest is called the feasibility space.

A couple of issues related to OptQuest are:

- A symptom of the age of the product is that the window for latest simulation end is now in the past.
- The user is also a developer, changing formulas and logic within the RPM worksheet to accommodate the needs of new cases.
- As a consequence, after running the system following various kinds of changes, it is important to check the repeatability of model results down to the last significant digit, in order to verify that the changes didn’t mess something up.

**Microsoft Access**

Two Microsoft Access databases are created in when using RPM. One is used as an intermediate step when preparing existing resource data for pasting into RPM. This step need not be repeated unless there is a major updating of the resource assumptions. The second Access database is created from the results of an RPM/Crystal Ball run, to support analysis of the results. This is repeated when the system is rerun with new input data values or new logic.

An advantage of Access is that it is convenient to move data between Access and Excel. A key limitation is that the maximum size of a database is limited to approximately 2 GB, while the results from Access for a given plan under 750 futures require approximately 1.5 GB. Therefore, Access cannot accommodate the results of more than one plan for the sake of comparison. Because the RPM and its ancillary utilities use a standard interface (ADO) to communicate with Access, data can also be exported to MySQL or SQLExpress, which have greater or unlimited capacity and are free, or to SQL, Oracle, or any other commercial-quality database.

What would not transfer directly, however, are queries. Access uses TSQL, a flavor of SQL that is similar to but not identical to ANSI SQL. Consequently, for a solution that makes use of the existing queries to produce reports, the user would have to use dynamic linkage of large external tables into Access. (The capacity of linked tables is unlimited in Access.) The disadvantage of this approach, however, is it tends to be relatively slow.

Another disadvantage of Access is it does not have the multi-user record locking and user data validation features that most other databases possess. While the former is probably not important to RPM users, the latter is very important. Cutting and pasting data from various sources increases the chance the user will accidently introduce invisible “garage” characters that destabilize or crash the database.
Windows
Windows is the operating system underlying Excel and Microsoft. RPM is currently restricted to an older version, Windows XP, because Crystal Ball 2000 does not recognize newer versions of Windows. This is another factor limiting the set of computers on which RPM may be run.

PowerShell
The current implementation of RPM utilizes distributed computing, whereby multiple futures are run in parallel on multiple processors. Up to nine worker computers and a master computer may be used. This reduces the elapsed time required for an RPM/Crystal Ball/OptQuest run. NWPCC implements these multiple computers as virtual machines.

The processors must be rebooted under various circumstances, as a prophylactic measure. (Ref. [1], 1) Use of virtual machines provides an advantage in that they tend to reboot more quickly than physical machines. NWPCC has used PowerShell scripting language to manage both the VM and the physical machines before them.

PowerShell does not seem to entail any additional risks, beyond being another utility and language with which the user must be familiar.

RPM Documentation
There is a lot of documentation for RPM, much of which is listed at the end of this report, in the Bibliography. However, each document was written as a stand-alone piece for a particular purpose. Examples are appendices written for the fifth and sixth power plans, to document the model methodology and assumptions for stakeholders, and pieces that document particular components or processes for users, such as preparing specific input data and analyzing results. There are also documents that are programming references, which discuss the strategy of the algorithm, the use and scope of variables, and the structure of more complex objects, like dictionaries and collections, module classes, and so forth. In some cases, a single document will contain all of these elements.

There are, also, a few gaps, some of which are identified in a work plan document, ref. [4]. The most comprehensive user documentation is a step-by-step guide to running RPM (ref. [1]). But there is not a single, coherent user manual. It assumes the model data has been updated and any modification of the formulas or code in the model has been implemented and tested. Nor is there a “map” to the documentation that would help a user determine in which documents to look for particular information.

If the current implementation of RPM is to be retained, then effort should be devoted to consolidating the relevant documentation in one location and to creating such a “map.” If RPM is redeveloped, then adequate effort must be devoted to creating complete and coherent documentation.
**RPM Staffing**

Ideally, the Council should have three or four staff members who are proficient in RPM, including running RPM and understanding and interpreting the input and output data. These three or four people do not need to work full time with RPM; in fact only one would likely spend more than half time with RPM. The other two or three would be working primarily on other things most of the time, but available to be assigned to help with running RPM during “crunch time” in producing a power plan, performing other studies, or interpreting RPM results for other staff and stakeholders.

These staff members should be primarily subject matter experts, not IT experts. They may have some IT expertise, but IT expertise should reside primarily with a model vendor (for issues related to model code and interfaces) and one or two on the Council staff (or issues relating to installation of RPM at the Council).

The current staffing situation at the Council seems, to the present author, to be unsustainable for two reasons:

- It relies on one critical person, Dr. Schilmoeller, who is both a subject matter expert and an IT expert, jeopardizing the RPM if this person is unavailable. Rather, multiple people should have the complete set of expertise required to run RPM.
- It will be difficult for the Council to find a replacement for this person, with the required level of expertise in both the subject matter and IT.

Reimplementation of RPM would address the need for expertise in both areas, by shifting a large part of the burden for IT expertise on the RPM vendor.

**RPM Reimplementation**

The Council must weigh several objectives in deciding the future form of RPM. These include:

- Human resources. These issues are discussed in the section on RPM Staffing.
- External use. A long-time goal of the Council has been to make RPM available for use by stakeholders and utilities. Stakeholders would use the model to analyze the impact of various assumptions and policy options. Utilities would use the model for analyzing their own resource needs.
- Transparency. As noted above, a key driver of implementation of RPM in Excel has been to make the logic of RPM visible to users and stakeholders. In the Excel implementation, others can trace this logic in the cell formulas. However, another way of achieving transparency would be to enable stakeholders to gain confidence in RPM by running the model for cases they may modify on their own and observing the effect of their modifications on model results.
- Ease of updating and burden of execution. RPM needs to be easy to update as assumptions change and as different policy options are analyzed. Similarly, if study results take an
An excessive amount of time, the exploration of issues so useful to policy-making becomes infeasible.

- Risk. Although RPM was developed to analyze the risk in various regional plans and policies, another type of risk is also important to the Council, namely, managing the risk that RPM will not be able to serve its intended role in development of a regional power plan.

- Availability for seventh plan. The Council needs to have RPM available for development of the seventh power plan.

- Communication with stakeholders. This should also address the problem RPM is intended to solve (analyzing risk of alternative plans and options) and what RPM is not (a hydro model, a detailed reliability calculator, or a complete model of the interconnected western system).

These considerations all weight heavily toward redeveloping RPM. At this point, the current implementation of RPM may be considered as a successful proof of concept, but not a commercial-grade software product. Going forward, with the retirement of Dr. Schilmoeller, the multiple objectives listed above will best be served by redevelopment of RPM.

A strategy for redevelopment is suggested by the right-most column, Priority, in Table 1. This column shows a recommendation for each component. The options for a component are:

- “1” denotes core functionality to be included in the base redevelopment project.

- “2” denotes other desirable functionality that is not necessarily critical to complete the seventh plan and could be selectively developed in parallel with core functionality once particular basic core design parameters are set, such as data storage architecture.

- “3” denotes functionality, such as input data preparation, that might best be left outside the new system.

- “4” denotes components that will not be needed in the new system because they would be either redundant or irrelevant.

The base redevelopment project (priority 1) would be the scope of work assigned to the commercial vendor. These priorities assume that redevelopment would be based on an overall architecture with the following features:

- A single, consolidated database containing all resource, forecast, and other input data and parameters, and output data for multiple cases

- Installation of the database and model at a centralized location

- Creating of a new model with all the functionality currently used in the existing implementation of RPM/Crystal Ball/ObjQuest

- Secure, remote access to the centralized system, possibly through a web browser, for Council staff, stakeholders, and utilities.

The redeveloped system would include the following characteristics:
• All data transfers to happen automatically through the database.

• A feature equivalent to the now-defunct Olivia tool, for creating a new RPM for a different system, may or may not be needed, depending on whether RPM calculations are implemented in an Excel worksheet or in code.

As stated above, owing to the multiple technological platforms, approximately 30 steps are required to run RPM. Approximately 21 (two-thirds) of these steps would be unnecessary in an integrated system with current technology because they could be accomplished automatically without user intervention. The following list indicates the nature of the steps that would be required in the new system (and the corresponding steps in ref. [1]):

1. Login to the system environment using a browser (1).
2. If a new case is required, then:
   a. Create a new edition for the index representing a case (6)-(8).
   b. Modify the data that are to be changed in the new case, and save with the new case edition name (9).
3. Navigate to the screen with run-time parameters (including tunnel constraints) (26).
4. Review and modify, as needed, the run parameters (28a).
5. Launch the run (28b).
6. Review messages and results for obvious problems (28d).

Some key steps that would be eliminated by reimplementation are the following:

• (2)-(5), (22)-(24) Any initialization would be accomplished automatically.

• (10)-(12), (15-20), (27) Most file copying, backing-up, loading, etc. would be accomplished automatically.

• (13)-(14) All necessary selection of environments will be made upon login.

• (21) Some error messages related to automatic processes will be largely eliminated by proper coding of interfaces and tasks. However, errors resulting from network problems, communications failure between master and slave processors, and license restrictions, could possibly continue to occur.

• (25) Any failure to initialize properly would become evident immediately after a run is initiated.

• (28c) Adjustment of Tailvar constraint will be accomplished automatically.

• (28e) Saving of results will be accomplished automatically.

The new model with all the functionality currently used in the existing implementation of RPM/Crystal Ball/OptQuest would include the features utilized in the add-ins, specifically:

• Generate correlated random variables (replacing Crystal Ball)
- Provide distributed computation capability (replacing CBTurbo)
- Provide optimization (replacing OptQuest), including
  - hot start capability
  - information from earlier simulations (Ref. [4], 3)

Redevelopment could selectively include some of the activities identified in Dr. Schilmoeller’s work plan (ref. [4]).

**Bibliography**


[7] M. Schilmoeller, "RPM study and development time estimates for CB and David Bellman".


Directions for RPM 130517.docx

Friday, May 17, 2013
Ken Corum, ed. by Michael Schilmoeller

This update reflects a change in operating environment (virtual machines) and new PowerShell scripting capability.

This documents the use of tools to perform several routine functions
- Using the RPM to create feasibility spaces
- Plotting the feasibility spaces in Excel and creating a summary worksheet of resource plans
- Basic data extraction for a single resource plan under 750 futures into an MS Access database, using the utility Export to Access (EtA) version 6.0
- Creation of a spinner graph, using a GUI in the MS Access database populated in the previous step

Other utilities for preparing and analyzing are described elsewhere
- Work plan for the RPM model and Olivia.doc (page 7 ff) describes
  - the Power Plant Insertion and Verification Utility for safely modifying cells and formulas in the RPM
  - the Import to Excel Viewer (ItE) utility for panning and zooming through data series created by RPM and stored in the MS Access database (see EtA 6.0) above.
  - a Snapshot Utility for creating a “hot” RPM model, loaded with a particular future
  - the MS Access database system for input data extracted from the Existing Projects workbook, including a dedicated GUI
- Reader Documentation 120806.doc, which permits the user to “spin” through futures, loading them into a copy of the RPM for tests or calculations.
- Instructions_for_use_of_RPM_Conservation_P03_120924.docx, which illustrates the use of the reader to replicate energy efficiency acquisition in the RPM

Before proceeding with any of this, there are a few key items of information you will want to collect:
1. Michael’s current network password. Most of these systems are installed under Michael’s user name (Schilmoeller) and will not run under alternative user names.
2. Access code for the computer room. If it becomes necessary to physically reboot and “hang” machine, you will have to get in the computer room to flip a power switch. This is not an issue with the virtual machines and new PowerShell scripts for rebooting machines.

Olivia Launch Sequence (full “feasibility space/efficient frontier”)

To do a full, clean launch, we need to reboot all the computers before executing the launch. While it is customary to shutdown a launch and start another without rebooting the system, the machines should be rebooted any time they have been left idle a few days, a run has crashed, or there are abnormalities seen with runs. Abnormalities include power and network failures, and mysterious and vague messages from CB or OptQuest such as “the workbook contains an error” or words to that effect.
**Reboot the workers**

1. VNC into vModel2
2. There is a folder named “Powershell scripts” on the desktop. Open the folder and find the script “CleanAndRestart 110527.ps1”
3. While it is acceptable to right-click on the script and choose “Run with Powershell,” you can also choose Edit instead and be taken into the cool PowerShell environment, where you will be able to examine code and syntax. From the PowerShell environment, hit the green “Run” arrow.
4. Wait until all the machines have been cleaned and rebooted. You will know this is the situation when the script reports, “Job Complete!”
5. You can now shutdown the VNC connection to vModel2. It will not be used for the subsequent simulations or analysis. The computer vModel2 stands apart from the RPM simulation environment, so it is a good place to “sandbox” new code and developments as well as to run scripts for the simulation machines.

**To prepare input data network folder files**

- The first three steps below are optional unless coordinating with Michael’s studies
- Go to Q:\ms\plan6\studies\L8XX, where L8XX is the name of the most recent model
- Create new folder (e.g. L813z)
- Make a copy of the appropriate study model or the base case model in the main subdirectory, depending on the nature of your study. Pick a version that minimizes the changes necessary. Place the copy in your new study subdirectory.
- Edit the new model.
  a. To “seed” this run with a nice low-risk first plan, edit the yellow cells in Sheet 1 R4:CE9 with MW from an Analysis of Optimization run that achieved a low risk with a plan something like you’re considering (e.g. no DR, or…). Use inputs from the row shaded light green (signifying least risk, usually down ~100 or so lines) columns E:AR. Take care to pay attention to the dates of the changes, as not all models have the same “start date for construction.”
- Copy the OptQuest *.opt file from the directory from which you copied the model. You will need to make an *.opt file for your study. Rename. Edit the file in WordPad to reference the name of your study. Other edits at this point are discouraged. The OptQuest conventions can take awhile to figure out.
- Copy the documentation file *.doc into folder, rename, and edit appropriately
- Optionally, copy Analysis of Optimization Run.xls from the root subdirectory for the model (not one of the subfolders) into your new folder. You do not need this file for the launch. You will rename and use this copy after the run is complete to pull the feasibility space information out of the OptQuest.log file.

**To launch job**

13. Open VNC window to vMaster. We must launch on a machine that has Excel 2000 installed, because our version of Crystal Ball will not run under Excel 2003.
14. It is typical that we keep all the RPM models in a central location on vMaster. It is important to run the RPM locally, rather than over a network, to minimize computation burden and interaction with routine network maintenance.
15. There is typically an OptQuest.log file left from the last run. Because this contains all the results from that run, we take care not to lose or destroy it. If OptQuest is started, OptQuest will wipe out this file and begin a new one. Consequently, rename this OptQuest.log file to something that identifies its associated study or otherwise describes it.

16. **Create a new, empty OptQuest.log file** by right-clicking and selecting “Make a new text file.” The new file will have the suffix, “.txt”. Change the name of the text file to OptQuest.log. The system will warn you. Accept the new name.

17. **Copy over the model and *.opt files** you created in steps 8 - 10.

18. Create a text log file by right-click and choosing to make a new text file. Rename it to something more suggestive. Michael uses “L8XX notes.txt”. Use this to log start time, progress on plan simulation, and lifting risk upper bounds manually. F5 will record the current data & time. Note the plan completed when each of these thresholds are crossed; the time does not matter and can be easily computed from the plan and date/time stamp from F5.

19. **Load your Excel model**.

20. Close the Sheet1 workbook that CB insists on opening.

21. If you receive the message, “Enable Macros?”, choose “Yes” and inform Michael. This would be non-standard.

22. Hit the key sequence <CTRL> M. This loads the name of the principal RPM model macros into the CB application. If you missed step 20, you will also be reminded to close the Sheet1 workbook.

23. Verify the RPM macros names have been properly loaded. Click on the “Run Preferences” button and look under “Macros”. The “After Game” and “After Simulation” slots should contain text that refers to the study workbook model. The rest of the settings should be fine, but if you care to check them, there are illustrations in the Fifth Power Plan, Appendix L, pages L-109 to L-115.

24. Hit the key sequence <CTRL> I. Nothing should happen unless something’s wrong. This sequence fires the Auto_Open macro in the model that initializes the model and does one complete pass on the calculation.

25. Verify the workbook is operating properly by examining the Total Study Costs near cell CV1000. If there are any problems, they will flow through to this total.

26. **Go to “CB Tools” on Menu, click on OptQuest**.

27. Open File on the menu, find the *.opt file for your study, and open it

28. Complete OptQuest configuration:

   Click on “Decision Variable” button, edit as appropriate (e.g. RM bounds and suggested value) click on “OK”

   Click on “Constraints” button, click on “OK”

   Click on “Forecasts” button, click on “OK”

   Click on “Options” button,

   **DON’T** change anything in “Advanced” tab

   **DON’T** click “Confidence testing”

   “Preference” tab, description = title, OptQuest log file = OptQuest.log*

   *to make sure this is correct, click on Change Log, check that folder is correct.

   Choose an adequate number of simulations to perform. You can end a study at any point, so there is no down-side to choosing something between 5,000 and 10,000. (We find 3,500 plans are necessary to identify the least-risk plan.)

   Hit “OK”
Launch by clicking green arrow (green triangle pointing to the right) and click somewhere else to see if problem window comes up

One routine prompt asks whether it is OK to “switch” to the active window. In this case, choose yes.

To change Tailvar constraint (“requirement” in sheet) click on “efficient frontier” icon (looks like a graph) Click on “Next Point” button at lower left of window to increment the upper limit risk constraint as the study proceeds.

**In case of problems:**

1. Check to make sure Model 1 is running
2. Click on “Define decision” button in CB to make sure limits of decision variables (e.g. RM) are defined and correct.
3. Examine our log, Descriptions of complaints 110127.doc
4. If feasible, do a screen capture of the offending error message

To kill run, click on “stop” icon (green square)
Close OptQuest window
Say yes to “Update optimization file?”
Say yes to “Copy results to workbook?” note.
Close workbook
Say yes to “Save changes?”
Copy files from vMaster to network folder for preservation. The workers and master are not typically backed up

**Creating the feasibility space graph and resource plans report**

Locate and load a template version of the “Analysis of Optimization Run.xls” workbook, usually located in the root folder for a given study model (“L813”, “L814”, etc.).
Remove read-only protection, if active.
Run the macro “sub_Process” (not Sub_Process2). How to run macros depends on the version of Excel. For example, under Excel 2003, click on Tools, Macros, and choose sub_Process
Rename workbook

**Extracting data (for spinner graphs, diagnostics, decile charts, etc.)**

Export to Access (EtA) 6.0 is a utility for extracting user-specified time-series data from RPM runs (single or multiple futures). The extraction tool EtA typically pulls data from the RPM model loaded with one particular resource plan as it processes 750 futures in normal (non-distributed Turbo) mode.

Thursday July 29, 2009

1. Copy target workbook into vMaster desktop
2. Obtain the most current version of “template for auditor.mbd” from the network folder.
   Each database template has a version of the form “yymmdd hhss” and associated documentation describing its contents and changes.
3. Copy, rename the template to a name consistent with your study. Remove read-only protection, if active.
4. Open Standalone Export to Access.xls
5. If workbook is target case, Control I
6. If workbook is not target case, hit Smiley Face (SF)
   a. Check range names in Non-conforming Range Names window, fix “critical” range names (check to see if they can just be deleted, otherwise ask Michael
   b. Check Export RPM Data to Database, double click (editing doesn’t work) on target.xls in top space -- window will close, hit SF again
7. Once target case workbook is open, don’t bring Standalone ExportToAccess 05.xls forward again.
8. Check Non-Conforming Range Names again, close window
9. Check Export RPM Data to Database, double click (editing doesn’t work) on target.mdb in second space -- select correct one from desktop
10. Click on menu button for Available Configurations space, select e.g. Rates ___090707
11. Enter Plan ID from target workbook
12. Go Back to Standalone Export to Access.xls, check to see if a workbook Book1 is open -- if so, close it
13. If “Reset Simulation” icon is green, hit it
14. Control M (should get a warning that another workbook is open -- it’s OK)
15. Hit “Run Preferences” icon (in CB bar, looks like a page)
   a. Manual (not Turbo),
   b. the Macro feature is pointing at the correct workbook. If not, hitting Cntl-M should reset it to the current workbook.
16. After entering description and plan number, hit Crtl-I again before hitting “Proceed” button.
17. Hit the “Proceed” button and close the verification message box
18. Close the EtA workbook and any other workbooks that may be open
19. Hit “Run” (green arrow/triangle in CB menu bar.)

CRITICAL: After hitting the “Proceed” button, do not hit Crtl-I again. This will undo the extraction setup, and you’ll need to start over again at step 6.

**Generating spinner graphs from RPM model**

1. In step 10 of the preceding description for Extracting data, select a “spinner graph” configuration (e.g., “spinner6 04”)
2. After the extraction is complete, 10-15 minutes, check progress by calling up model, looking at task bar
3. When finished, “max trials reached” will display
4. Close the RPM workbook – saving is not necessary
5. Open the associated MS Access extraction database locally (avoid running database activities over a network).
6. Double-click on the form “frm spinner prompt”
7. Enter info in window’s top 3 spaces (see Figure 1 below). These will be used to name and document the spinner graph workbook.
8. Copy most recent spinner template workbook (e.g., SpinnerTemplate_091215_1430.xls) from subfolder where these are kept to the active folder. Remove read-only protection, if active.

9. Hit “create spinnergraph” -- watch run status until done

10. In the working folder, there should appear a new workbook, “Spinner_yymmdd_hhmm_<studyID>.xls. The user specified the studyID in the dialog box (Figure 1)

**Olivia launch sequence for a single-plan, 750 futures**

The following would be performed for special studies. Steps 13 to 16, and 19, in the preceding description for Extracting data outline to key steps to setting up and running the model.

Data for forecast cells (only) can be extracted from a completed run without the use of the EtA tools, using built-in Crystal Ball features:

1. Hit “extract data” button
2. Click on “all” under “Forecasts” in the window that comes up
3. Hit “”FC values” or “statistics”) under “type of data”
4. Name worksheet that is created to keep results straight (e.g. “L811Y3 FC”)
5. **NOTE:** “TailVar columns in extractions aren’t valid -- ignore those columns
6. To get e.g. TailVar90, create a new worksheet (name appropriately), copy Total Costs, sort by size, select highest 75 (highest 10%) and calculate average
7. Extract any other data needed by repeating first 3 steps above.